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GENERAL MEETING REPORT
February 14, 2017
By Leah Clark, LACS Editor
Speaker: Arleen Mills
Metro Rail Train Operator

Arleen, a Los Angeles native, has been with
Metro for 25 years and has been a train opera-
tor for 12 years. To become a train operator,
one must have excellent standing with Metro,
and it takes a minimum of three years. Metro
invests about $30,000 for a person to become a
full-time operator. The training is very serious
and intense. It seems they go to school forever
to learn how to operate the very complex
system. They learn to read lights differently,
how to change tracks and to operate switches
manually.

There are two systems: Automatic Train
Operation (ATO) and Manual Train Operation
(MTO). The systems are unbelievable; the
amount of protection for the passengers is
amazing. The operators have to have their
radios on 24/7, and they had better be
listening. If the operator misses a code, the train
is stopped right then. The trains read lights, so
they will never go past a red light. If the
operator passes out, has a heart attack, or loses
physical touch, the "Deadman Feature" will shut
the train down. The train will never allow the
operator to interface with another train. It will
lose power. With the radio, there is never a lost
connection. The passengers have the same
direct communication to the operator. Aboard
every car is a Platform Telephone (P Tel). They
have cameras, so if you activate P Tel, they can
look at you. Help is always available, and all
passengers can feel empowered.

Arleen has had emergencies, like a train losing
power. Three of the trains run on light rail, and
the red line is heavy rail, which has 750 volts of
direct current. You never want to get near any
of that power. The operators are first
responders. They make sure that everybody
gets off the train. If that ever happens to you,
remain seated to give the operator time to get
to you, to explain what's going on, and to walk
you safely to the platform. Ballasts are rocks that
are made for railroads. It's not natural rock. It is
porous and turns color when wet. This is to

make sure the track isn't sinking and remains
level.

Every train system has what's called a duck-out
path. If you ever fall on the tracks, go under the
platform. It is hollow for a reason. If you fall on
the red line, you never want to go to the wall
because of the high current. If you drop
anything, leave it. The operators will come to
you, and go down there. If you see somebody
fall, find a P Tel and find some way to
communicate. Call 911. One of the things you
can do is find a gate. There is one on each end -
just open it.

If you are lost or confused as to where you are,
it may be an emergency to you. Do not allow
the word "emergency" to prevent you from
accessing any of the system. If you lose
something, contact the operator by the P Tel.

Every car has a number. Whenever you get
into a car, make a mental note of the number,
so you can tell someone where you are. Stay
clear of the 18-20 inch beveled edge. Don't
ever lean out.

When the train is operating on the automatic
system, and it ever stops for any reason, or
someone is suspected to be in danger, the
operator takes over the system manually.

Speaker: Charles Weissman
Supervisor Engineer

Charles manages the engineering operation
and the maintenance of the computers.

He supervises all the stops and all the trains
from one place, so people don't have to be
spread all over the system in order to run the
trains. All systems are computerized, including
the telephones and the radios. The radio is a
digital system, like a little computer. It talks to
the bigger computers.

They operate 105 miles of rail, and have
760,000 boardings per week, with a total of 96
stations.

Trains do not need computers to run! Comput-
ers are needed to increase safety, reliability
and efficiency. They help connect the passen-
gers, operators, dispatchers, maintainers, man-
agers and emergency responders.

Computers are used for everything! They en-
able Metro to control all aspects of rail opera-
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tions and infrastructure from one central loca-
tion. Computers are used aboard the trains to
enforce safety and to implement automatic oper-
ations. They enable all these computers to talk to
each other and to share information with the out-
side world.

Functions of rail computers:

e Automatic train protection, control and oper-
ation

o Supply of power to trains and stations
Passenger and emergency telephone
systems

Elevators and escalators

Public address and closed circuit Television
Fire, life and safety security systems

Public information system

They are not the computers you are used to.
Computers in rail systems interact with the phys-
ical world. Sensors detect location, smoke and
crossing gate position. Actuators track switch
position commands, station evacuation messag-
es, and circuit breaker close commands.

Safety is still primarily the responsibility of peo-
ple, Metro and patrons. Computers control
crossing gates, but people must not try to go
around them. Computers turn signals red and
automatically stop trains. Operators must obey
the signals. Cameras provide surveillance, mak-
ing sure people aren't jumping over the edge, or
there's not a crime being committed. Personnel
must monitor the video and initiate the security
response. Computers alert of equipment fail-
ures, but personnel must respond appropriately.
Systems must be tested and retested by people.

Supervisor Control and Data Acquisition
(SCADA) is a fancy name for saying it's a com-
puter that monitors and controls things. Gates,
signals and switches are all controlled from a
computer screen.

Charles showed very intricate slides depicting:

Typical Train Dispatcher Display
Rail SCADA Systems

Train Detection

Transit Signaling

Safe Train Separation

Signalized Interlocking
Protected Gate Crossings
Unprotected Intersections.

FROM YOUR EDITOR

Let's Get To Know Our Members

LACS has members who don't attend meet-
ings for various reasons - distance, health,
etc., so we never get to know them. Each
member has an unique story to tell about
education, work experience, family, inter-
ests, and accomplishments.

I would like to go alphabetically down our
roster and publish two to three bios each
month. Each could be about 100 to 200
words. I will send an email each month to
the next in line. I hope many will partici-
pate in this project. You may also submit
your bio out-of-turn!

I use a lot of articles and reviews from mem-
bers of other user groups in User Friendly. |
would like to publish contributions from our
own members. Do you use any hardware,
software or utilities that you really like or
dislike? Why not share your experience with
LACS members? Do you have any specific
expertise or knowledge you could write
about?

Socializing before the March 14
General Meeting.
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DAYTIME SIG REPORT
By Leah Clark, LACS

his report is a summary of some of the items
that were talked about during this meeting.

One member has been bothered by a pop-up
from Malwarebytes Premium saying, "Real-
Time Protection layers turned off." When she
checks the settings, everything is turned on.
Apparently, this is a known bug that may be
fixed with a later update.

Members were interested in how long Windows
7 would be supported. It will probably be until
about 2020. Some would like to buy a Windows
7 laptop, but Jim suggested getting Windows
10. A major Windows 10 update is due in March
or sometime in the spring. It will be version
2017 03. They keep releasing little fixes fre-
quently. There have been compatibility prob-
lems with Windows 10 and peripherals like
printers, etc.

Jim likes Epson, Canon or Brother printers. He
likes Epson for its water-resistant DURABrite
ink. He has tested printers in the store and then
taken the pages home to test with a drop of wa-
ter. Epson printers also have a tray to enable
printing directly onto a CD.

Wireless printing and cloud printing were dis-
cussed. One can print from a phone or in some-
one else's home with cloud printing. When you
set up the printer, set the software to be com-
patible with a phone, tablet, etc. Some printers
allow you to print directly from a phone.

There was a discussion on refilling vs. using
name-brand inks. Jim does not recommend re-
furbishing Epson cartridges. He likes auto du-
plex printing.

A member tried to delete a printer no longer in
use from a computer. All programs connected
to the printer must be removed. Go to Devices
and Printers, delete the icon, and the printer
should be gone.

Jim doesn't like the Edge Browser, saying it's
the worse part of Windows 10.

In the past we had floppies, then CDs, now flash
drives. The largest are now 512 GB and use USB
3. Some are very tiny, making them easy to lose
and to steal. Micro SD cards that plug into a
phone are good for spies!

With mesh routers, two to four units can talk to
each other throughout a house. They are useful
for managing wireless in large areas. There
will be no weak signal anywhere in the house.
A power line adapter extends the network
through power lines; this is a wired system.
www.fast.com is an Internet speed test. There
was an active discussion on routers, network-
ing and DNS servers.

With Malwarebytes, one never knows if all mal-
ware has been removed. Something can be
hidden away to come back to attack again.

LifeLiock monitors activity from your Social Se-
curity number and account numbers to protect
you from identity theft.

YouTube videos can be chopped up due to In-
ternet speed that is too slow. When this hap-
pens, you may try to hit Pause and let the whole
video download, then replay.

Bill announced the Linux Scale Expo coming up
in Pasadena.

There are programs to compare files and to
find duplicate files. Some can find duplicates
even if they have different names.

Gmail, if used through an email client, will have
no ads or pop-ups.

The eight persons who were present learned a
lot and enjoyed the fellowship. ¢

BASICS & BEYOND SIG REPORT
By Leah Clark, LACS

Paula Van Berkom showed us how to use Mail
Merge to create customized letters or labels
from a single Word document. She started with
a letter. She demonstrated using an Excel
spreadsheet mailing list. (The process is similar
in other office programs like Libre Office.) First,
you need to select an existing address list or
prepare a new one. The column names must
match the field names you want to insert in your
mail merge. For example, First Name, Last
Name, Address, etc. Then, you write and open
your letter.

Click on the Mailings tab > Start Mail Merge
> Select Recipients > Use Existing List >
Browse to your Excel spreadsheet > Open >
OK.


http://www.fast.com
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You can editl the recipient list or sort your list
alphabetically, by state, etc. You can select or
deselect names by adding or clearing the check
next to the names.

Put your cursor in your letter where you want a
name or address block. On the Mailings tab >
Insert Merge Field > Select Address Block,
Salutation or Greeting Line. In the Insert Ad-
dress Block dialog box, choose a format that
matches the way you want it to appear. You can
edit the size and font and select OK. Choose
File > Save. Follow the same procedure to in-
sert a Greeting Line.

On the Mailings tab > Write and Insert Fields
> Insert Merge Fields > Fields > Choose a
field name (column name in your spreadsheet) >
Insert. Chevrons around the field names act as
placeholders.

In the Finish group, choose Finish & Merge
and select Print Documents.

To preview your letter, on the Mailings tab >
Preview Results. Choose Next or Previous to
move through your letters. You can save your
letter as a template and edit your list. Changes
in the list will reflect in the letter. You can save
all the letters or just one letter.

If you make a change in the column names of
your spreadsheet, it won't show in the letter. Go
to Match Fields to match the fields. Go to Insert
Merge Fields to add additional fields to the ad-
dress block.

Mailing labels are created in a similar way. Go
to Mailings > Mail Merge > Labels. Choose
your label stock or size, your recipients, and
complete the merge. Paula suggested you test-
print your labels on plain paper to check the
alignment to avoid wasting label stock.

At the end of the Meeting, Paula talked about
Ninite, a free download that updates multiple
Apps at once, without getting crapware or
toolbars.

Go to www.ninite.com, check the Apps you
want to update, and click on Get Your Ninite.
Follow the prompts to learn if your chosen
Apps are up-to-date, were updated, or were
installed.

About ten members were at this meeting.

Please tell Paula what topics you would like
presented at this SIG. ¢

CO-AUTHOR WORD 2016
DOCUMENTS IN REAL TIME
By Nancy DeMarte, 1st Vice President,
Sarasota Technology User Group, FL
Sarasota Technology Monitor, Nov. 2016
www.thestug.org
ndemarte (at) verizon.ne

S ometimes we need to get another person’s
input on a document while we’re compos-
ing it. In the past, we had to email versions of
documents back and forth, with markups and
comments. Office 2013 introduced a system
where two users could see the same document
on their screens at the same time, and both
could make changes, although the changes
weren’t visible to the other person until they
were saved. Office 2016 has upgraded and
simplified this process. Now two or more users
can edit the same document at the same time
from different locations, and both can see
changes being made as they occur. This is
called real-time co-authoring. It isn’t difficult at
all. And it works with Word documents, Pow-
erPoint presentations, and Excel workbooks.
I'll use Word 2016 in Windows 10 to explain
the steps:

1. Be sure you have OneDrive active on your
computer, which might involve signing in to
your Microsoft account. This free cloud loca-
tion, which is built into recent Office versions,
is where you can store documents and access
them from anywhere over the Internet.
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2. Create a folder in OneDrive just for the pur-
pose of co-authoring, and give it a name, like
Share or Co-Author. Then save your document
to this folder by clicking the File tab — Share —
Share with People - Save to Cloud. (Fig. 1)
Navigate to your One Drive’s Co-Author folder
and click Save.

Share

Real Time Co-authoring in
Word

Documents » 1 5TUG » Office Talk Column » Co-...

Share H

Save to
Cloud

Share with People
® Step 1: Save your document to

= Step & Share your document,

l.ﬂ.‘ Share with People

[

—"  Email

Figure 1 - Share window in Word 2016

3. Now you are ready to invite a person or
team to join you to edit your document. Click
the Share icon on the right end of the ribbon.
(Fig. 2) In the ‘Invite people’ box, enter one
more email addresses or names to access your
Contacts list. Leave ‘Can Edit’ as the choice
and add a short message if desired.

Nancy DeMarte [ X

9. Share [

Figure 2 — Share icon above ribbon

4. Then choose a sharing method from those at
the bottom of the Share pane. I prefer to use
“Get a Sharing link” (Fig. 3) because my co-
author will find his document opening either in
his version of Word or in Word Online if he
doesn’t have Word 2010 or later on his comput-
er. Word Online offers fewer editing options,
but it works well for most editing tasks and can
be used even by people who don’t have Word.

Send as attachment
Get a sharing link
Publish to Docs.com

Figure 3 - Sharing
Options list

Click “Create an edit link,” (Fig. 4) then
highlight the link that appears, and click
Copy. Close the Sharing pane, open a new
email message, paste the link into it, and
send it to your co-author(s). Anyone who
gets this link will be able to edit your
document.

Share v X

€ Get a sharing link

Edit link

Create an edit link

Anyone with this link can edit the documents you
share.

Figure 4 — Create an edit link dialog box

5. Your editing partner has a choice of wheth-
er to let you see his changes as they are be-
ing made. To do this, he must click the File
tab — Options — General, and, in the Real-
Time Collaboration section, Always Click in
the Drop Down Menu. This option can be
changed at any time. If he has chosen not to
let you see changes in real time, you can
only see them when he saves the document.
(Fig. 5)

During the editing process, colored flags
appear in the spot each editor is working.

Alerts appear when an editor arrives or
leaves. Co-editors can communicate with
each other during editing by clicking Com-
ments in the ribbon at the top of the page to
chat.

Nancy DeMarte & X

-, R

Figure 5 - Share icon showing one co-author

The best way to learn this process is to experi-
ment. Ask a friend to be your test co-author and
go through the steps. As usual, practice, if done
properly, makes perfect. ¢
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BROWSER POP-UP SCAMS

By David Kretchmar, Computer Hardware

Technician, Sun City Summerlin Computer

Club, NV

November 2016 issue, GigiBytes Gazette

WWW.SCS-CC.com

tomburt89134 (at) cox.net

Windows 10 has proven itself to be the most
secure Windows operating system ever,

so hackers seem to be turning to another vulner-

ability. Browsers (Internet Explorer, Edge, Fire-

fox, and Google Chrome) are becoming a prime

target of scammers.

If you are at all adventuresome exploring the In-
ternet, you probably have had a browsing ses-
sion interrupted by a pop-up visual often accom-
panied by an obnoxious audio warning to the ef-
fect that your computer has been infected and
you must call a toll-free 800 (or 8XX) number to
prevent something terrible from happening to
your hard drive or data.

This warning is bogus; usually this “threat” can
be deleted by simply closing your browser.

To protect yourself from serious malware infec-
tion, you must be careful about how you close a
pop-up window. Specifically, you should never
click anywhere in a pop-up window. Even but-
tons labeled "Cancel" or "Close" or a red-X but-
ton in the upper-right corner are dangerous to
click; doing so could trigger an infection.

Safely close a pop-up window

To safely close a pop-up window, locate the but-
ton in your Taskbar that represents your brows-
er. Also, look for other highlighted icons on the
Taskbar. The button and the pop-up will usually
have a similar name. Right-click on the button
and select Close.

If that doesn't work, you need to use the Win-
dows Task Manager to close the pop-up. Simulta-
neously press the CTRL, ALT, and DEL keys, and,
from the resulting window, select Task Manager.
In the Task Manager, under the Processes tab,
highlight your browser application and click the
End Task button. It is probably a good idea to
close all applications except the Task Manager,
unless you are comfortable identifying non-
problem items.

Occasionally, you will have to power down
your system to remove the problem, either by
holding in the start button on your computer
for 10 or so seconds or unplugging your tower.
If the problem occurs on a laptop computer,
the battery must also be removed to power
down the computer completely.

What has happened to my system?

Usually the pop-up described above does no
lasting damage to your computer. It is “only” a
URL (Internet site) function with some unique
properties. The purpose of the URL function,
which you experience as a pop-up, is to fright-
en the user into calling the toll-free number. A
con-man (it seems to be a male, usually), prob-
ably on the other side of the world, will at-
tempt to extract as much money and data from
you as possible to remove the threat.

e

|

M

Usually, the scammer will attempt to get the
caller to initiate a remote connection to the vic-
timized computer. The remote connection can
then be used to make it appear that the scam-
mer is examining your system. Often addition-
al software, such as a Citrix program, which is
a legitimate application, is loaded into your
system to increase the scammer’s control of
your computer.

Never call any phone number that appears
The scammer might trick you into granting
them remote control of your computer. This
might enable them to install a backdoor, grant-
ing scammers the unfettered ability, now and
in the future, to harvest any or all the infor-
mation contained on your system, to be used
for any purpose. Never allow anyone you don’t
know to remotely log in to and use a computer
that you own and control.

Inevitably, the scammer discovers some terri-
ble problem with your computer. You are in-
formed that you will be required to pay a sub-
stantial fee to have the problem removed
and/or prevent future problems. ¢
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LACS NOTICES

WELCOME ALL
George Wolkon
Data Base Manager, LACS 6 6

New Members (1) N’
Juan Dominguez

Renewals (8)
Irv Hershman
Robert Hirshon
Robert Kraus

Bruce Lane
Clarene Long
Sheila Moncavage
Howard Krivoy William Oppenheim*

* Contributor

FIX YOUR PC FOR FREE?

Jim McKnight has an open offer
to all LACS members to diag-
nose, repair, disinfect, or up-
grade members' PC’s for free.
There are certain limitations to Jim'’s offer, so
see the details by clicking the “Fix my PC for
Free?” link at www.jimopi.net .

Non-members can wisely invest in a one-
year LACS membership ($40.00), and Jim will
fix your PC problem, too.

PODCASTS
To listen to the podcasts of our general meet-
ings, go to http://www.lacspc.org/category/
audio-files/. Click on the session you wish to
hear.

HOW TO CHANGE YOUR CONTACT
INFORMATION
Go to www.lacspc.org. Click on Member
Forms in the bar under the picture. Under
Membership Update, select Click Here for
either the DOC or PDF form. Fill it out and
bring it to a meeting or mail it. Or send your

changes to membership@]lacspc.org.

LACS IS ON TWITTER AND
FACEBOOK

On Twitter, follow us at:
https://twitter.com/LA CompSoc

We are sorry that the LACS Facebook page
is temporarily down. Please watch User
Friendly and your email for notification of its
return. If you would like to help to maintain it,
please contact our president.

GENERAL MEETING
PRESENTATIONS
April 11: Cloud Storage and File Backup
with Dropbox and Google Drive
May 9: TBA
Note: This schedule is subject to change.
Check email and User Friendly for updates.

LACS HAS JOINED MEETUP

Our Meetup group is called: "Los Angeles
Computer Society and Technology
Meetup."

Go to http://www.meetup.com/Los-Angeles-
Computer-Society-and-Technology-Meetup/

and click on "Join Us." Also, RSVP for our
general meetings. Please join - it's free. If it is
seen that a lot of people are interested, oth-
ers will be encouraged to join. We hope this
will result in new members for LACS.

GENERAL MEETING SNACK
SCHEDULE
By Sylvia Q. Davis, Hospitality Chair
Refreshments and socializing will be at 7:00,
with the meeting starting at 7:30. Please
bring refreshments at 7:00.

April 11: E throughI
May 9: J through N
June 13: O through 8
July 11: T through Z
August 8: A throughD &

Bring finger-food treats such
as fresh fruit, veggies, nuts, cookies, cold
drinks and the like. LACS provides hot drinks.

See your email for updates.

Please pick up your left-overs and serving
pieces at the end of the meeting.
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Tuesday |Wednesday Thursday Friday | Saturday

2 3 hoad 4 5 6 7 8

Meeting

7:00 PM
9 10 . 11 Generar |12 13 14 ..|15

il | Muving
Q'b‘c) 7:00 PM 1:30 PM Friday
16 11 18 19 20 21 22 Farih Day
23 24 Digital Photo 25 Dpaytime 26 21 28 29
SIG 7:00 PM SIG
30 1:00 PM

Watch your email for the dates of future meetings at the Microsoft Store.

This Calendar may change.
Check your e-mail or with the SIG leader before attending a meeting.

General Meeting: Fellowship Hall on the 2nd Tuesday of the month at 7:30 PM.

Most SIGs meet at the Santa Monica College Bundy Campus, room 235, unless otherwise noted.
The Daytime SIG meets at the Felicia Mahood Senior Center.

The Board may meet at Charlotte Semple's home or at Santa Monica College. Members in good
standing are welcome to attend.

SPECIAL INTEREST GROUPS (SIGs)

SIG meetings are led by and for LACS members. Visitors are welcome to attend.
For information about a SIG, check your e-mail or call the contact person in advance.

Basics & Beyond SIG Paula Van Berkom 310-398-6734 2nd Mon. 7 PM SMC, Bundy Campus
Daytime SIG Jim McKnight 310-823-7829  4th Tues. 1 PM, Felicia Mahood Ctr.
Digital Photo SIG Nancy Cattell 310-452-2130

" Elliot Silverstein 310-670-1544  4th Mon. 7 PM, SMC, Bundy Campus
New SIGs can be created if there is sufficient interest and leadership.

ADDRESSES
Felicia Mahood Senior Center, 11338 Santa Monica Blvd., West LA 90025 (at Corinth)
Fellowship Hall, Westchester United Methodist Church, 8065 Emerson Ave., Westchester 90045

Santa Monica College Bundy Campus, 3171 S. Bundy Drive, LA 90066 (west on College Dr.,
1 block South of Airport Avenue, 2 blocks North of Rose.) Our room number may change each
semester. Look for it on a sign opposite the elevator on the first floor.
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MEMBERS HELPING MEMBERS

LACS members volunteer to help other members solve hardware and software problems by
telephone during the hours listed below. Select the topic from the list and then call a person
whose number is listed next to it. Or you may use a Helper’s e-mail address, found in your
LACS Roster. We hope that you find this free service useful. If you are experienced using a
particular program or topic, please volunteer to be a consultant. To volunteer for this list or
to make corrections, please e-mail or call Leah Clark at Leahjc (at) sbcglobal.net or at 310-677-
2792. More Quick Consultants are always needed. You may decline or postpone a call if it
comes at an inconvenient time.

Adobe Creative Suite: PDF, L.A. Free Net-6 Photoshop - 17
InDesign, PhotoShop, etc. - 17 Linux - 11 Picasa - 14
Android Smartphones - 5 Lotus Word Pro, Approach - 12 Quicken -3, 5
Apple devices - 15 Mozilla Firefox, Thunderbird - 12 Thunderbird - 12
Anti Malware - 12 MS Excel - 3, 15 Visual Basic - 13
Digital Imaging, Editing - 8, 14 MS Word - 3, 4, 10 Websites - 13
Digital Photography - 8, 14 MS Outlook - 5, 15, 17 Win7- 16
Dragon Naturally Speaking - 4 MS Outlook Express - 15 Windows - 5, 12
Genealogy - 5, 7 MS PowerPoint - 15 WordPerfect - 5
Hardware - 12 MS Publisher - 2, 7
iPhone, iPad, iPod - 18 Open Office - 16

Preferred Phone

No. Name for Calls From To
2  Mercer, Bob 310-837-5648 9:00 AM 10:00 PM
3 Wilder, Joan 310-472-8445 9:00 AM 9:00 PM
4  Hershman, Irv 310-397-9453 11:00 AM 11:00 PM
5 Nordlinger, Stephanie 323-299-3244 5:00 PM 10:00 PM
6  Springer, Karl 424-646-3410 10:00 AM 10:00 PM
7  Clark, Leah 310-677-2792 9:00 AM 5:00 PM
8 Silverstein, Elliott 310-670-1544 10:00 AM 10:00 PM
10 Beckman, Loling 310-471-7893 10:00 AM 6:00 PM
11 Hughes, Bill 424-259-1818 Any Any
12 McKnight, Jim 310-823-7829 8:00 AM 7:00 PM
13 Ialongo, Gilbert 310-641-7906 9:00 AM 5:00 PM
14 Schneir, Jerry 310-451-4140 9:00 AM 10:00 PM
15 Van Berkom, Paula 310-398-6734 9:00 AM 5:00 PM
16 Johnson, Carol 310-372-8535 10:00 AM 9:00 PM
17 Rozek, EJ]. 310-823-3811 Noon 8:00 PM




EPRIL 2017 The Los Angeles Computer Society Roster Prce 11
OFFICERS, DIRECTORS AND LEADERS
Title Name Term Telephone
President Stanley Johnson 2017 424-216-6984
Past President Maurice Stephenson 2017 310-625-0450
Vice President Stephanie Nordlinger 2017 323-299-3244
Secretary Lee Freehling 2017 310-837-4022
Treasurer Charlotte Semple 2017 310-398-5052
Director Leah Clark 2018 310-677-2792
Director Jim McKnight 2018 310-823-7829
Director Emil (E.].) Rozek 2018 310-823-3811
Director Paula Van Berkom 2017 310-398-6734
Director George Wolkon 2017 310-459-2671
APCUG Rep. Leah Clark 310-677-2792
Car Pools Vacant - Please volunteer
Changes Karl Springer 424-646-3410
" George Wolkon 310-459-2671
Corporate Counsel Stephanie Nordlinger 323-299-3244
CCSC Computer Lab Loling Beckman 310-471-7893
Hospitality Chair Sylvia Davis 213-924-4927
Asst. Hospitality Chair ~ Vacant - Please volunteer
Membership Database =~ George Wolkon 310-459-2671
Newsletter Editor Leah Clark 310-677-2792
Program Chair Stephanie Nordlinger 323-299-3244
" Stanley Johnson 424-216-6984
Publicity Mark Presky 310-398-0366
Quick Consultants Leah Clark 310-677-2792
SIG Coordinator Vacant - please volunteer
Webmaster Paula Van Berkom 310-398-6734
Welcome Chair Irene Mussack 310-672-3077
Asst. Welcome Chair  Linda La Roche 310-645-4546
Contact Information
Website www.lacspc.org Newsletter Editor Leahjc (at) sbcglobal.net
Voice Mail 1-310-398-0366 Webmaster sitemaster (at) lacspc.org
e-mail ContactUs (at) lacspc.org Change of Address membership (at) lacspc.org

The ContactUs (at) lacspc.org address goes to our president and vice-president.

If the message is for another board member, they will forward it to the correct person.

To contact other officers, directors, leaders or members directly, members may use our roster for
phone numbers and e-mail addresses.


http://www.lacspc.org/category/audio-files/
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WINDOWS 10 CORNER

By Rosita Herrick

Sarasota Technology User Group. FL

Hrosita (at) aol.com

‘ n ’ indows 10 has been around now for over
a year, so I thought it was time to person-

alize the computer screen and the mouse to in-

dividual taste.

Mouse

To change the mouse size and/or color:
Type "mouse settings" in the Cortana search
box and click on the link (as shown below).

Change your mouse settings
System settings

At the bottom of the page, click on the Addition-
al mouse options (in blue at the bottom of the
page.)

The page with mouse properties as seen below
will pop up.

If you are left handed, you can switch the but-
tons by checking the top square. You can also
experiment with the Double-click speed. If you
change any of the options, the Apply box will no
longer be gray and to keep the change, click on
Apply and the OK.

On the top of Mouse Properties are additional
tabs.

Buttons Pointers Pointer Options Wheel Hardware

Clicking on Pointers will display another page
allowing you to change the mouse pointer

looks.
acneme

(None) %

Save As_. Delete

To change the pointer, click on the grayed box
and a list will be displayed. Click on any item

za
Buttons Pointers Pointer Options Wheel Hardware

Button configuration
[_] Switch primary and secondary buttons

Select this check box to make the button on the
right the one you use for primary functions such
as selecting and dragging.

Double-click speed

Double-click the folder to test your setting. If the
folder does not open or close, try using a slower

setting.
Speed:  Slow ' Fast

ClickLock

DTum on ClickLock Settings

Enables you to highlight or drag without holding down the mouse
button. To set, briefly press the mouse button. To release, click the
mouse button again.

OK Cancel

Apply

on the display, and it will change as seen
below.

Scheme

Windows Black (extra large) (system scheme)  ~

Rk

Save As..

Again, experiment with the way you want
your pointer to look and then click Apply
and OK.

The pointer options tab lets the user select
additional options like Motion, Snap To and
Visibility.

As you can see below, on my PC I chose:

Hide pointer while typing and Show loca-
tion of pointer.

If the “show location” is checked, pressing
the CTRL key on the keyboard will show a
circle around the pointer for a few seconds.

Hide pointer while typing

{} Show location of pointer when | press the CTRL key
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I recommend, if you intend to change any of
the default options, first write down the current
options so that, if you want to change them
back, you know what the options were.

Changing Screen display
Right click on any open space on the screen.

As you can see in the next picture, wherever
there is a caret more information is displayed.

Personally, I chose to show small icons and to
show desktop icons. If on your desktop the

icons are scattered, clicking on Auto Arrange
or Align icons to grid will straighten the icons.

View >
Sort by >

Refresh ® Small icons

Large icons

Medium icons

Paste Auto arrange icons

Paste shortcut

Align icons to grid

& ntel® Graphics Settings

v/ Show desktop icons
NVIDIA Control Panel

Next desktop background
New

Q Display settings

& Personalize

oG Wi
The New line enables the user to create a Fold-
er or a Shortcut.

Folder
@ Shortcut

To create a program shortcut, you can click the
Browse button to search for a specific program
executable file. To create a shortcut to an In-
ternet page, just type the URL in the blank
space, click Next to continue, give it a short
name on the next page and click Finish. To
change the icon’s picture, right-click on it,
click on Properties and click on the Change
Icon box. Deleting an icon is just as easy. Right
click on the icon and click on Delete. The icon
will be deleted from the screen only.

If the text displayed on the desktop is too
small, clicking on the Display settings link
brings up a page to increase or decrease text
size by using the slider.

Change the size of text, apps, and other items: 150%

Advanced display settings

Clicking on the Blue link lets the user change
the resolution. Normally, the native resolution
of the display shows in the box as
"Recommended".

Resolution

1920 x 1080 (Recommended) v

DEEDMAPPER

Presented by Mary Stewart, Northern
Neck Computer Users Group, New Jersey
Genealogy SIG Meeting Recap
The Computer Link, October 2016
www.nncug.net
geocadjr (at) verizon.net
D eedMapper is software that one can use

to plat old land patents, grants, and
deeds, and place them on a modern map. It is
particularly useful when surveys are done with
metes and bounds as was customary in our ar-
ea. It also works with public lands.

With DeedMapper, you can find the location of
a particular plot by anchoring a group of
neighboring plots against a stream. You can
also discover genealogical relationships by
showing that person X sold part of person Y’s
land. It can untangle people having the same
name by analyzing their landholdings and
transfers.

With DeedMapper you can create a map of
original landholders in a region. You can
also trace changes in parcel ownership over
the years.

Mary told us about Land Records in Genealogy
and explained what State Lands are.


http://www.nncug.net
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Twenty colonies and states did not cede the un-
claimed land in their borders to the federal
government when they became part of the Unit-
ed States. These states are known as State Land
states and included the original 13 colonies,
those states created from the original colonies,
plus Hawaii and Ohio.

Why research deeds? Researching deeds can
help you determine family relationships and
establish death dates. Upon the death of a wid-
ow, her dower interest goes to her husband’s
heirs.

Mary demonstrated how DeedMapper works
by starting with the survey of Gerard Alexan-
der’s land. She showed how she took the infor-
mation from the survey and inputted it in the
Metes and Bounds function of the program. Af-
ter entering the information into the program, it
created a map of the property boundaries. It
also produced a map of what the property looks
like today. Mary advised all this information can
produce a view of the property in Google
Earth. She was able to find Col. Gerard Alexan-
der’s home that was built in 1820 in Campbell
County VA.

To learn more about DeedMapper, go to
www.directlinesoftware.com. A book Mary
recommends for discovering your ancestors is
Locating Your Roots: Discover Your

Ancestors Using Land Records by Patricia Law
Hatcher. More information about the book can
be found at www.genealogical.com. ¢

INTERESTING INTERNET FINDS

By Steve Costello
Boca Raton Computer Society
editor@brcs.org
http://ctublog.sefcug.com/

n the course of going through the more than

300 RSS feeds, I often run across things that I
think might be of interest to other user group
members.

The following are some items I found interesting
during the month of October 2016.

What Is a Solid State Drive? Should I Buy
One?
https://www.maketecheasier.com/what-is-
solid-state-drive/

If you keep hearing about SSDs and don't real-
ly know what they are, or if you should get
one, check out this post for more information.

Disposing Of A PC? Nuke The Drive First.

http://www.techsupportalert.com/content/dis
posing-pc-nuke-drive-first.htm

This post talks about and links to freeware to
wipe a hard drive completely.
Should You Keep Your Landline?

http://tech-moxie.com/should-you-keep-
your-landline/

More and more people are going cellular.
Check out this post to help you decide if you
should do so too.

How to Find Free Prime Reading Eligible
Kindle eBooks

http://blog.the-ebook-
reader.com/2016/10/08/how-to-find-free-
prime-reading-eligible-kindle-ebooks/
Amazon added the Prime Reading perk in ear-
ly October 2016. This post tells you how to find
them, if you are an Amazon Prime member.

12 Ways to Secure Your Wi-Fi Network
http://www.pcmag.com/article2/0,2817,24097
51,00.asp

This PC Magazine posting provides infor-
mation about securing you wi-fi network. Even
if you think you are doing everything you can,
you should check this out.

How to Protect Your Privacy on Public WiFi
Networks
http://www.techlicious.com/tip/how-to-
protect-your-privacy-on-public-wifi-networks/

Good information you should know if you must
use public wi-fi.

Should You Buy a Roku Box or a New Smart
TV?
http://www.guidingtech.com/61986/roku-or-
smart-tv/

This post has some things to keep in mind if
you are thinking of replacing your TV.

Most Fridays, more interesting finds will be posted
on the Computers, Technology, and User Groups Blog:

http://ctublog.sefcug.com/tag/interesting-internet-
finds/

The posts are under Creative Commons licensing. ¢



http://www.directlinesoftware.com
http://www.genealogical.com
http://www.techsupportalert.com/content/disposing-pc-nuke-drive-first.htm
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http://tech-moxie.com/should-you-keep-your-landline/
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http://blog.the-ebook-reader.com/2016/10/08/how-to-find-free-prime-reading-eligible-kindle-ebooks/
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https://www.maketecheasier.com/what-is-solid-state-drive/
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MONITOR AND PROTECT YOUR PRECIOUS DATA WITH
HARD DRIVE SENTINEL
Review by Gabe Goldberg
Potomac Area Technology and Computer Society
APCUG Representative
APCUG Advisor, Region 2
ggoldberg (at) apcug.org
S torage devices are unappreciated workhorses: spinning hard drives and immobile memory
chips reliably and rapidly save and fetch your data, year after year. Until -- uh-oh, something's
wrong and where's my data?!

I've been running HD Sentinel (HDS -- http://www.harddisksentinel.com/) for about five

months on two computers -- my desktop system and my wife's laptop. It's a powerful tool for moni-
toring storage device health, and for learning more about how they work than you likely imag-
ined possible. While the tool's website focuses on simple hard drives, HD Sentinel also supports
other storage devices: SSDs, SSHD (hybrid drives), memory cards and thumb drives (where
available), tape drives, and RAID controllers.

On both my systems, I've configured it to show icons for each connected hard drive: one on the
laptop and three (one internal, two external) on my system. By default, the icon shows current
disk temperature (with green/orange/red visually indicating status). Mousing over icons displays
a summary of disk health, and clicking opens the entire display.

Overview Display

e Disk: 2, WDC WD5000BEWT-00ZATO [WD-WXNI08NVEE03] - Hard Disk Sentinel 4.71 PRO = & =
File Disk View Report Configuration Help
7N s e I I | ) 1)
COH$3EX R IRV EHD QD
WDC WD5000AAKX-60UGAAD (465.8 GB) Disk: 0 o Overview ‘& Temperature | s SMART. | 14 Information | E] Log | 0 Disk. PErformanr_El ﬁj Aler‘ts‘
° Health: 100 % C: [System], E: [Data 1] o Performance: [ 100 % ] Excellent ®
Temp.: 84 °F F: [Data 2], [System Reserved]
: — 100% 3
WDC WD20NMVW-11EDZS3 (1863.0 GB) Q@ Healh [ J Excellent @
&  Health: 100 % Disk: 1 The hard disk status is PERFECT. Problematic or weak sectors were not found and there are no spin up or data transfer errors @
Temp.: 88 °F G: [My Passport]
No actions needed.
WDC WD5000BEVT-00ZATO (465.3 GB)
o Health: 100 % k: 2
Temp.: 83 °F I: [WDC 500GE]
Sl e Power on time: 2242 days, 14 hours ®
Free Space 135.1 GB. Disk: 0 Estimated remaining lifetime: more than 100 days B -
E: [Data1] (1465 GB) Total start/stop count: 48,739
Free Space 136.3 GB Disk: 0 Click to add comment ...
F: [Data 2] (1240 GB) [ Heath 4 |
Free Space 123.9 GB Disk: 0 =)
G: [My Passport] (1863.0 GB)
Free Space 1862.7 GB Disk: 1
I: [WDC 500GB] (4658 GE)
Free Space [IFWIALET) Disk: 2 Jto0} f1o0f {00 f1o0f [too} foo; fvoo} {100} o0} {too} {o0F {100} oo} {100} {100
15
£ ¢ g @ ¢ £ ¢ £ £ & £ = § & ¢
S =] =) =] b =] =] =] =1 =] =] =) =] =] =)
o o = = = = = = = = = = = = =
= = = - - - - - - - - = = = =
4 3
Status last updated: 11/13/2016 Sunday 8:20:14 PM
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Temperature Display

& overview & Temperature | SMART. 1) Information | =) Log | @ Disk Peformance | [ Alerts

o Current Temperature: [ == ] Set custom temperature thresholds
Q Average Temperature (today): [ 8780 °F ]
o Maximum Temperature (today): [ 30°F ]
Maxirmum Temperature (during entire lifespan): [ 17 °F ]
| Maximum Temperature (ever measured): [ 116°F ] 6,/24/2016 6:52:10 PM
‘_‘ Minirmum Temperature (ever measured): [ 75 °F ] 8/18/2016 8:03:30 AM

Temperature status is good.

Itis recommended to calibrate the temperature and set the temperature offset onthe S.MAR.T. page. This way later the correct temperature
value will be displayed.

Current (°F) | Daily Average (*F) | Daily Maximum (*F) | Daily Minimum (*F)

(Z]

120_ ....................................................................................................................

1154

1104

1054

1004

G

PP EEr L EEEEEEEEL L EEFEEEEEEEEEFEEEEFEEEEEEE RN LS

] 2%

B0+

75

T4

EE‘-F""I""'I""F'"1'"'T""I'""I""T""I""'I""I'""I""'I""r'"'I""T""r""I""T""I""'I""r""l""'l
= = = = = = = = = = = = = = = = = = = = = = = = =
o o [Vl [Vl [Vl o o o [Vl o [Vl [Vl o o o o [Vl [Vl o o o o o [Vl [Vl
(vl (1] [vs] (o] =t = =t =t =t =t =t =t = =t =t f =t =t = =t = =t =t =t =t
a a [} [} a a a a [} (] [} a a a ] (] [} a a a [} a o [} a
o — (o] (] =t w o — (o] (1] =t w o -— (o] [xz] =t w o -— (o] [vs] =t 0w o
[ ¥y ¥} [¥e} ¥} I i} [ia] [is]} [ia] [is]} [is] P P P~ P F P [} o [} o fua] [a} a3

86 B B 3 = 90 84

HDS can be used for maintaining one's at-a-glance comfort level. I like all my drives described,
"The hard disk status is PERFECT. Problematic or weak sectors were not found, and there are no
spin up or data transfer errors. No actions needed." For drilling into drive history, I like tempera-
ture patterns, various sorts of errors, performance information and more listed.

For many years, hard drives have included S.M.A.R.T. (Self-Monitoring and Reporting Technolo-
gy) technology -- https://en.wikipedia.org/wiki/S.M.A.R.T. -- described as "a monitoring system
included in computer hard disk drives (HDDs) and solid-state drives that detects and reports on
various indicators of drive reliability, with the intent of enabling the anticipation of hardware fail-
ures." But annoyingly, most operating systems don't easily make that information -- and recom-
mendations or warnings -- available. At least twice, based on such warnings, I've been able to re-
place drives in the process of failing before any data was at risk. So, I'm a firm believer in having
software running to disclose drive information while there's time to act on it.
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S.M.A.R.T. Display

|—° Overview I & Temperature| e SMART. 1'/ Information | E) Log | @ Disk Performance | |._D Alerts|

Mo, Attribute
°1 Raw Read Error Rate 51

@3 spinUp Time 1
4 Start/Stop Count 1]
@5 Reallocated Sectors Co... 140
7 Seek Error Rate 1]

9  Power OnTime Count 0
@10 Spin Retry Count 51

11 Drive Calibration Retry ... 0
12 Drive Power Cycle Count 0
192 Power off Retract Cycle .0
193 Load/Unload Cycle Cou...0
194 Disk Temperature 1]
01.96 Reallocation Event Countd
01.9? Current Pending Sector...0
01.98 Off-Line Uncorrectable .0
199 Ultra ATA CRC Error Co.., O
@ 200 Write Error Rate 51

oo

Raw Read Error Rate

Threshold  Value Waorst Status Data Offset Enable
200 200 OK 00000000007 = 04
200 154 OK 000000003 BE =-| 0 |4
52 52 OF (Always..00000000BEGS = 0|4
200 200 OK 000000000000 = 0 |4
100 253 OK (Always.. 000000000000 - 0|4
27 27 OK [Always...00000000D23E =| 0 |4
100 100 OK 00000000000 - 04
100 100 OK (Always...000000000000 = 0 |4
100 100  OK (Always...0000000000E0 = 0 |
169 169  OK [Always...000000005D38 - 0 |
152 152 OK [Always...0000000238E6 - 0 |
116 100  OK (Always...00000000001F =| 0 4
200 200 OK (Always.. 000000000000 =-| 0 |4
200 200  OK (Always.. 000000000000 = 0|4
100 253 OK (Always... 000000000000 - 04
200 200  OK (Always.. 000000000000 - 0|4
100 253 OK 00000000000 - 04

Flags

Show values

el

B13/201 6
B/22/201 6|

7172016
THO201 6
TH9/201 6
TI28/201 6|

8/5/201 6

85720161

Attribute graph

Self Preserving, Error-Rate,
Performance, Statistical, Critical

B/24/201 6
0/2/201 6
9117201 6
9/20/201 6
0/29/201 6|
10/8/201 6|
104 7/201 6
10/26/201 6
11/45201 6
111372016

[ Display data field

Information Display

|7° Overview | @ Ternperature | = S.M‘A‘R.T.| -?( Information ‘ = Log |0 Disk Performan(.el uj Aler‘ts|

“e® Hard Disk Summary
Hard Disk Number
Interface
Vender Information
Disk Controller
Hard Disk Model ID
Firmware Revision
Hard Disk Serial Mumber
Total Size

Power State;

% Logical Drive(s)
Legical Drive

“e® ATA Information
Hard Disk Cylinders
Hard Disk Heads
Hard Disk Sectors
ATA Revision
Transport Version
Total Sectors
Bytes Per Sector
Buffer Size
Multiple Sectors
Error Correction Bytes
Unformatted Capacity
Maximum PIO Mode
Maxirnum Multiword DMA Mode
Active Multiword DMA Mode
Maxirmum UDMA Mode
Minimum multiwerd DMA Transfer Time

2

SAT Standard USB/ATA

WID: 1058, PID: 0705

Renesas Electronics USE 3.0 Host Controller (USE 3.0) [VEM: 1033, DEV: 0194] Versio...
‘WDC WDS000BEVT-00ZATO

01.01A01

WD-WXNI0BNVEG03

476937 ME

Active

m

I: [WDC 500GEB]

969021

16

63
ATAB-ACS
SATA Rev 2.6
976773168
512

8192 KB

15

50

475940 MBE
4

2

2

300 MB/s (5)
120 ns

HDS is developed, main-
tained and supported by
a dedicated developer
who is passionate about
his product and brilliant
at both tech support and
answering questions
about product usage. It's
available at a bargain
price for a lifetime license
with no renewal or sub-
scription costs and free
version upgrades. It's a
worthwhile investment in
both knowledge and com-
fort. 4
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CASH FLOW
As of February 28, 2017
Charlotte Semple, Treasurer

Total Assets $ 8,093.50
Receipts $ -

Total Gross Receipts §$ -

Expenses
Newsletter 261.56
Facilities Rental 60.00
Verizon Wireless 50.08
Total Expenses $ 371.64

Current Total Assets $ 7,721.86

Focal Press

Taylor & Francis Group

Check out the latest books on digital imaging
and photography, gaming, animation, film
and video, postproduction, audio, music
technology, broadcast and theatre from
Routledge | Focal Press today! They will send
special offers and discounts to User Groups.

Get 40% off print
& 50% off ebooks
at oreilly.com.

Code: PCBW

Orders over $29.95
qualify for free shipping
inthe Us.

OREILLY"

Any works by Leo Notenboom of Ask Leo! that are
printed in User Friendly are licensed under a Crea-
tive Commons Attribution-NonCommercial -
INoDerivatives 4.0 International License. User
Groups have permission to use them.

ILAUGHING OUT LOUD

New Old Computing Sayings
The Internet has changed everything, even
these tried and true traditional sayings:

e Wherever Ilay my @, that's my home.

e The email of the species is deadlier than the
mail.

e A journey of a thousand sites begins with a
single click.

e Great groups from little icons grow.

e Speak softly and carry a cell phone.

e Don't put all your hypes in one home page.
e Pentium wise, pen and paper foolish.

e The modem is the message.

o The geek shall inherit the earth.

e A chat has nine lives.

e Don't byte off more than you can view.

e Faxis stranger than fiction.

e What boots up must come down.

e Windows will never cease.

e In Gates we trust (and our tender is legal).

e The words of the Prophets are written on
the Facebook wall.

e Virtual reality is its own reward.
e Modulation in all things.
e There's no place like home dot com.

e Oh, what a tangled Web site we weave
when first we practice.

e Speed thrills.

A user and his leisure time are soon parted.

From http://www.guy-sports.com/humor/
computers/computer 10laws.htm

NOTICE
The columns, reviews and other expressions of opin-
ion in User Friendly are the opinions of the writers and
not necessarily those of the Los Angeles Computer
Society. LACS became a California non-profit corpora-
tion on July 17, 1991. Its predecessor was the UCLA PC
Users Group.

The Editor of User Friendly will accept contributions of
any suitable length from members. Send articles to
Leahjc (at) sbcglobal.net as plain text in an e-mail
message or as a Word document. The deadline for
submitting articles is the 20th of the month.

COPYRIGHT © 2011

by the Los Angeles Computer Society, an all-volunteer,
tax-exempt [IRC Section 501(c)(3)] nonprofit California
corporation. All rights reserved. User Friendly is pub-
lished monthly. Subscriptions are included in member-
ship dues. Reproduction of any material here by any
means is expressly prohibited without written permis-
sion, except that other nonprofit User Groups may re-
print LACS articles in substantially unaltered form if
credit is given to the author and this publication and an
e-mail is sent to leahjc(at)sbcglobal.net reporting the

reprint information (user group and the name and date



https://www.routledge.com/focalpress?utm_source=shared_link&utm_medium=post&utm_campaign=160701200
http://www.guy-sports.com/humor/computers/computer_10laws.htm
http://www.guy-sports.com/humor/computers/computer_10laws.htm
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MEMBERSHIP In addition to monthly -- Special Interest Groups
INFORMATION general meetings, members (SIGs) on various selected

Annual membership Dues: enjoy these special benefits: | topics to help to you learn, to

Regular $ 40 -- Monthly Newsletter share interests, and to solve your

Family-Associate 12 User Friendly. We publish your | computer problems.

Students 18 article submissions or free -- Information on training, swap

Six- Month Trial 25 classified ads to buy or sell meets and trade shows.

Renewal, Electronic your computer items. -- Occasional Free software and

Newsletter 30 -- Get FREE help by phone computer books, if you review

Contributing 50 from knowledgeable members | them for User Friendly.

Supporter 15 who are Quick Consultants -- Rewards for recruiting; LACS

Benefactor 100 listed in User Friendly. will extend your membership for

A subscription to User Friendly
is included with membership.

Associate members are those
who live in the same household
or work for the same company
as a regular member; they do
not receive their own subscript-
tions to User Friendly, but may
read it on the LACS website.
Students must prove full-time
status.

-- Get help by e-mail by
using our LACSLIST Yahoo
Group Mail List. Send your
questions by e-mail to
lacslist (at) yahoogroups.com.

-- Receive important news
and announcements via LACS’s
Yahoo Group e-mail lists.

-- Occasional product
discounts, special offers, etc.

three months for each new regular
member you recruit.

-- Annual Holiday Party
-- Field trips

-- Social Interacting with others
who have like interests in comput-
ers and technology.

-- Computer Conferences

-- Virtual Technology Confer-
ences

Membership/Renewal Application

Please bring your dues and this form to a meeting or mail them to:

Los Angeles Computer Society, 11664 NATIONAL BLVD. #343, LOS ANGELES CA 90064-3802

Please PRINT Clearly
[ ]1Regular - $40.00 [

] Associate - $12.00 [

[ ]New

[ ]Renewal
] Student - $18.00

[ ] Renewal with electronic, no paper, newsletter - $30.00 [ ] 6 month trial membership - $25.00

[ ]Contributor - $50.00 [ ]Supporter-$75.00 [ ]Benefactor-$100.00 [ ]Other$
Name: First Last
Name of Associate: First Last

Address:

City, State, Zip + 4

Day Phone:

Evening Phone:

[ ]Do not publish in roster

e-mail Address:

Who invited you to join LACS?

Revised: January, 2017 ljc



Editor................. Leah Clark
Electronic Editor ..Karl Springer
Indexer .............. Leah Clark

Podcast Transcriber: Irv Hershman
Photographer....... Vacant

Proof Readers ...... Lance Hegamin,

Jim McKnight, Stephanie Nordlinger and
Charlotte Semple

FREE!

Earn 3 months of free

membership for every new regular
member you bring in.

User Friendly is published by the Los Angeles Computer Society.
11664 NATIONAL BLVD, #343 LOS ANGELES CA 90064-3802

Voice-mail: 310- 398-0366. Web site: http://www.lacspc.org

DIRECTIONS TO
GENERAL MEETING

Westchester United Methodist
Church Fellowship Hall

8065 Emerson Ave.

Los Angeles CA 90045

From the North:

Take Sepulveda Blvd. SOUTH
to W. 80th St. Turn WEST/right. 5
Go about one mile to Emerson
Ave. Turn SOUTH/left. Go one
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long block to W. 80th Place. It 8l a L

is on the Northwest corner of @ ; b

Emerson and W. 80th Place. sdirio| 4 i E 13063 EMERSON  [esrr
O = I T 5 -

From the South, East or West: % cﬂ) § a2 § U[muﬂfp._? B

Take Manchester Ave. to @B 8T e st \

Emerson Ave. Turn NORTH. Go \ R e IS T 1 \\

about eight blocks to W. 80th BT

Place. Fellowship Hall is on the . BITH T

Northwest corner of Emerson
and W. 80th Place. There is
street parking and a small
parking lot West of the church.

2
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